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Managing Projects

In this chapterThis document was prepared especially for distribution with Service

Pack 3 for Autodesk Civil 3D 2007. The content will appear in an ■ Understanding Project
Management

updated form in the online User’s Guide for Autodesk Civil 3D

2008.

■ Managing Data Using Data
Shortcuts

■ Managing Data Using Vault

Autodesk Civil 3D offers a range of options for managing

engineering projects. Once you understand these options, you

can determine the best data structure for your projects.

■ Vault Best Practices

■ Working with Vault

■ Working with Vault Projects

■ Working with Vault Project
Drawings

■ Working with Vault Project
Objects

■ Working with Vault Project Points

■ Data Shortcut Command
Reference

1

1



Understanding Project Management
Depending on project complexity, your project management system can range
from a few drawings in a folder to large database with shared objects and
security controls.

When deciding on a structure to use for managing your projects, consider
these factors:

■ The number and complexity of drawings

■ The size of the project team and number of people requiring access to the
files

■ The relative need for ease of use versus data security

Best Practices

This section provides general suggestions for any project management system.
More specific suggestions are included in the separate sections Using External
References (page 4), Using Data Shortcuts (page 6), and Using Autodesk
Vault (page 8).

■ Create a structure of project folders and files that enables every member
of the team to readily find the data files they need, and save all drawings
in the right place.

■ Apply meaningful, specific names to all files and objects that are shared
within a project environment. Default names such as “Alignment – (1)”
can be especially confusing, as they can appear in multiple drawings, and
they have no reference to a real-world object.

■ For basic objects such as surfaces and alignments, save one object per
drawing for maximum flexibility. This drawing structure enables one team
member to open a drawing for edit while other members can operate with
read-only copies. On a small project, you may decide to store several objects
in the same drawing if they will always be edited by the same person. For
example, if a project includes several inter-connected alignments, you
might decide to manage all of them within a single drawing.

■ As an exception to the guideline of one object per drawing, when using
data shortcuts or Autodesk Vault, create each profile in the same drawing
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as its parent alignment. This data structure ensures that the profile can be
referenced as a separate object and shared with other drawings.

Transition from Land Desktop

Compared to the standard format used in Autodesk Land Desktop, project
structure within Autodesk Civil 3D can be customized to suit your
requirements.

Autodesk Civil 3D includes an Import Data From Land Desktop command on
the File menu. This command makes use of the following dialog box, which
enables you to selectively bring objects into new drawings for use in Autodesk
Civil 3D.

Transition from Land Desktop | 3



The recommended use of this Import function is to bring individual surfaces,
alignments, or pipe runs into new drawings, one object per drawing, for use
in Autodesk Civil 3D projects.

Object Sharing

Sharing design objects such as surfaces and alignments across drawings can
provide major savings in project timelines, if done correctly.

Three main options are available for sharing data within a project:

■ External references (Xrefs)

■ Data shortcuts

■ Object references in Autodesk Vault

Each option is discussed in one of the following sections.

Using External References

An external reference (Xref) inserts into the current drawing the entire contents
of another drawing as a display-only object. This is a standard AutoCAD
function.

To insert Xrefs, click Insert menu ➤ External Reference and insert a specified
DWG into your current drawing. Objects in the referenced drawing cannot
be edited, but you can use Layer Manager to control the display of separate
components.

Advantages of Xrefs

■ Xrefs are versatile and easy to use for different DWG types, whether they
contain a single object or a complete design.

■ Updates to the external drawing appear automatically in the host drawing
when the drawing is opened, and notification of updates is provided during
the host drawing session.
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■ All the content of the reference drawing is displayed, such as a base drawing
containing parcel layout, existing ground information, or a proposed
grading plan.

■ Xrefs can be used with either data shortcuts or Autodesk Vault.

Limitations of Xrefs

■ Because they are display-only, they provide no access to object data such
as surface elevations or alignment length. For example, you cannot create
a surface profile from a surface in an Xref. Both data shortcuts and Vault
object references provide access to object data.

■ They provide no inherent security. Anyone can break links by moving or
renaming referenced files.

Best Practices

Select Relative Path as path type when creating Xrefs. Where all document
users share the same network environment, use UNC (universal naming
convention) paths to provide a flexible but accurate path to each referenced
file.

Xrefs are best used when you will not need to manipulate objects within the
referenced file. This might be the case when you import drawings of adjoining
surfaces into plan sets.

Sample Uses

■ Display a parcel layout within an alignment drawing.

■ Display existing ground information within a design drawing.

■ Display adjoining project phases in a plan set drawing.

For more information on Xrefs, see the AutoCAD Help topic Reference Other
Drawing Objects.
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Using Data Shortcuts

A data shortcut provides a complete reference copy of an object that you can
import into one or more other drawings.

Creating a data shortcut is a two-stage process. First, the data shortcut is
exported from its source drawing as an XML file. Then a reference to the XML
file is imported into one or more consumer drawings. Objects in the consumer
drawing have access to the geometry of the reference object in the data
shortcut. This geometry can be modified only in the source drawing, not a
consumer drawing. However, display styles and labels for the reference object
can be modified in the consumer drawing.

When an object is updated in the source drawing, notification appears in the
main application window and in Toolspace Prospector.

Multiple objects from a single source drawing can be stored in one XML file
and imported in one operation, but for data integrity reasons it is
recommended that each object be saved to a separate XML file.

Data shortcuts can be created only for surfaces, alignments, profiles and pipe
networks.

To create data shortcuts, click General menu ➤ Data Shortcuts ➤ Edit Data
Shortcuts.

Advantages of Data Shortcuts

■ They provide a simple, direct mechanism for sharing object data that is
based solely on drawings, without the added server space and
administration needs of Autodesk Vault. This can be ideal for small teams
or small projects.

■ They offer access to an object’s geometry in a consumer drawing while
ensuring that the object’s geometry can only be changed in the source
drawing.

■ Reference objects can have styles and labels that are different from the
source drawing.

■ Reference objects automatically update when you open a file in which you
have referenced data.
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■ During a drawing session, you are notified when a source drawing has
been modified, both in the Communication Center, and in the Prospector
tab of the Civil 3D Toolspace.

Limitations of Data Shortcuts

■ They cannot provide data versioning.

■ They provide no security or data integrity controls.

■ Unlike Autodesk Vault, data shortcuts do not provide a secure mechanism
for sharing point data or survey data.

■ Maintaining the links between the data shortcut XML files and the source
drawings requires a static location on the shared file system.

■ If you want to check a DWG with data shortcuts into Vault, the shortcuts
must be deleted, then rebuilt as Vault object references.

Best Practices

■ When creating shortcuts, export each object into a separate XML file. This
separation of data can ensure that if a file or link is corrupted, only one
object is affected.

■ Store each XML file in the same folder as its source drawing. Doing this
makes it easier to find both items and to understand their relationship.

■ Save and name each consumer drawing before importing a data shortcut.
Doing this ensures that the consumer drawing saves a relative path to the
source drawing. Then if you move the project or set of drawings to another
location, the references remain intact because the relative path does not
change.

■ In a network environment, use UNC paths to provide a flexible but accurate
path to each XML file.
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Sample Uses

■ Reference a surface and a pipe network into a drawing where you want to
design a grading plan. You can grade to the target surface even though it
is just a reference.

■ Reference a surface and a related alignment into a drawing where you want
to create profiles in a profile view. This data structure enables you to keep
profiles in a separate drawing from the alignment in accordance with the
best practice of “one object per drawing”.

For more information, see Managing Data Using Data Shortcuts (page 9).

Using Autodesk Vault

Autodesk Vault is the recommended project management option for large
design teams working with Autodesk Civil 3D.

The main database resides on a designated server, such as a file server on the
network, and client software is installed on each computer that requires access
to the database.

Vault allows you to share surfaces, alignments, profiles, pipe networks, points,
and survey data.

Advantages of Autodesk Vault

■ This robust database management system provides user security, data
integrity protection, version control, and backup and restore functionality.

■ It facilitates design collaboration among large teams and is easily scalable
when a team grows.

■ It incorporates new features from Autodesk and Microsoft as they become
available with software upgrades

■ Shared objects can be easily created when a drawing is checked into the
database and these are managed effectively by Vault.
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Limitations of Autodesk Vault

■ It requires at least double the disk space needed by other project
management systems, because all files exist both in the Vault file store,
and in one or more external working folders.

■ It requires ongoing server administration activities.

Best Practices

■ Designate one team member to be trained as a system administrator and
to perform these duties regularly.

■ Assign database access permissions to user groups rather than individuals.
This enables you to change the permissions for an entire group, and to
change users’ permissions by moving them to another group.

■ See also Vault Best Practices (page 35).

Sample Uses

■ Reference a surface and an alignment into a drawing where you want to
design a parcel network. The parcel design can read the surface and
alignment geometry. You can also apply display styles and labels to the
surface and the alignment that are relevant to the parcel design process.

■ To create a plan set drawing, reference in several profiles and a surface
created from a corridor.

For more information, see Managing Data Using Vault (page 17).

Managing Data Using Data Shortcuts
This section explains the detailed concepts and procedures for managing data
shortcuts.
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Creating a data shortcut involves two processes:

■ Export a data shortcut from the source drawing as an external XML file.
This file identifies the path to the source drawing, the DWG file name,
and the object name.

■ Import the XML file into a consumer drawing to create a reference. The
consumer drawing stores the path to the reference object in its source
drawing. The XML file is no longer required if the relative location of the
two drawings does not change.

The reference object has read-only geometry, but the user can apply a local
object style, apply custom annotation, do limited analysis, and access the
source object's properties. The reference object takes up less file space when
the consumer drawing is saved.

Data Shortcut Types

Data shortcuts can be used for surfaces, alignments, profiles and pipe networks.

Alignment and profile data shortcuts are closely related. A profile and its
parent alignment should always be in the same drawing. If you maintain this
structure, then you can export data shortcuts for both the alignment and the
profile. If you import a reference alignment into a drawing and create a profile
in the consumer drawing, you will not be able to create a profile shortcut from
the consumer drawing.

Creating Data Shortcuts

Create a data shortcut by exporting an object reference to an XML file.

All data shortcuts in the Data Shortcuts vista at the time of export are included
in the new XML file. For maximum flexibility in object sharing, create a
separate data shortcut for each surface, alignment, or other object to be shared
from a drawing. To do this, you must create, export and then delete each
shortcut from the Data Shortcuts vista before creating and exporting another
one.

NOTE You cannot create a data shortcut to another data shortcut.

For more information, see Exporting and Importing Data Shortcuts (page 11).
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To create data shortcuts

1 Click General menu  ➤ Data Shortcuts ➤ Edit Data Shortcuts.

2 In the Data Shortcuts vista, click  .

3 In the drawing, select the object for which you want to create a data
shortcut.

The data shortcut is created.

To make the data shortcut accessible to other drawings, you must export
it. For information, see Exporting and Importing Data Shortcuts (page
11).l

Once the link to the Source drawing has been created via the XML file, the
reference drawing will save the relative path to the source. As a result the XML
file does not have to be reloaded unless the paths to the source drawing have
changed.

Quick Reference

General  ➤ Data Shortcuts ➤ Edit Data ShortcutsMenu

Dialog Box Data Shortcuts Vista

Exporting and Importing Data Shortcuts

Export data shortcuts from their source drawings and import them into
consumer drawings.

As a best practice, when you export data shortcuts, save each XML file in the
same folder as its source drawing.

After a shortcut has been imported into a consumer drawing, the reference to
the source drawing remains in the consumer drawing. The XML file is not
required again unless one of the drawings is moved or renamed.

NOTE When you export a profile shortcut, a shortcut for its parent alignment is
also exported.

Exporting and Importing Data Shortcuts | 11



To export data shortcuts

1 Click General menu  ➤ Data Shortcuts ➤ Edit Data Shortcuts.

2 In the Data Shortcuts vista, click  .

3 In the Export Data Shortcuts dialog box specify a path and enter the data
shortcut’s XML filename. Give the shortcut XML file the same name as
the source drawing (default) or the name of the source object contained
in the drawing, if the drawing contains only one source object.

4 Click Save.

To import data shortcuts

1 Click General menu  ➤ Data Shortcuts ➤ Edit Data Shortcuts.

2 In the Data Shortcuts vista, click  .

3 In the Import Data Shortcuts dialog box, browse to the location of the
data shortcut’s XML file, and select it. Click Open.

Quick Reference

General  ➤ Data Shortcuts ➤ Edit Data ShortcutsMenu

Dialog Box Data Shortcuts Vista

Deleting Data Shortcuts

Delete data shortcuts by deleting their source XML files.

Delete the XML files only if you are creating new ones to reflect data changes,
or if you are sure that they are not required by any consumer drawings.

To delete data shortcuts

1 In Windows Explorer, browse to the location of the data shortcut’s source
XML file, for example: <installation-directory>\Civil 3D
projects\<project-name>\Surfaces
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2 Delete the file.

NOTE Existing consumer drawings that reference any deleted source drawings
will have to be modified to delete the broken references.

Troubleshooting Data Shortcuts

Identify and correct problems with data shortcuts or their source drawings in
several ways by validating the data shortcuts or opening their source drawings.

Validating Data Shortcuts

Data shortcuts can become invalid if changes occur to the names or locations
of drawings or reference objects.

The  icon is displayed next to invalid data shortcuts in the Data Shortcuts
vista:

■ The data shortcut’s source drawing cannot be found.

■ The data shortcut’s source object cannot be found in the source drawing.

You can validate (reload) the data shortcuts if the drawing paths have not
changed. Otherwise, you can use the Data Shortcut Editor to edit the path to
the source drawing.

To validate data shortcuts

1 Click General menu  ➤ Data Shortcuts ➤ Edit Data Shortcuts.

2 In the Data Shortcuts vista, click  .

When the data shortcut is validated, the  is no longer displayed.
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Quick Reference

General  ➤ Data Shortcuts ➤ Edit Data ShortcutsMenu

Dialog Box Data Shortcuts Vista

Accessing the Data Shortcut Source Drawing

Open and edit a data shortcut’s source drawing.

You can access a data shortcut’s source drawing if its path can be resolved.
This is useful if the source object requires editing.

To access a data shortcut source drawing

1 Click General menu  ➤ Data Shortcuts ➤ Edit Data Shortcuts.

2 In the Data Shortcuts vista, click the data shortcut in the Name column.

3 Click  .

NOTE The  button is not available if a data shortcut is not selected or if
the data shortcut is invalid because its drawing cannot be found.

The source drawing for the data shortcuts is displayed in a new document
window.

Quick Reference

General  ➤ Data Shortcuts ➤ Edit Data ShortcutsMenu

Dialog Box Data Shortcuts Vista

Referencing Data Shortcuts

To use a data shortcut, create a reference to it.
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After the source object is updated, you can synchronize a reference to get the
latest version of the source object. Also, you can promote a reference to an
independent object so that you can edit it.

For information on creating references, see:

■ Creating a Surface Reference

■ Creating an Alignment Reference

■ Creating an Profile Reference

Synchronizing References

Synchronize any references to the data shortcut when a data shortcut’s source
object is updated.

When a drawing contains references to data shortcuts, the  icon is displayed
at the bottom-right side of the window:

When references become out-of-date with the data shortcuts, the  icon
displays a message prompting you to synchronize the references. Additionally,

in the Prospector tree, the  icon is displayed next to reference objects that
need to be synchronized.

To synchronize a reference object

1 In Toolspace, on the Prospector tab, expand the drawing node. Expand
the object collection (for example, Surfaces).

2 Right-click the out-of-date reference object. Click Synchronize.

NOTE The Synchronize menu item is displayed only for reference objects
that are out-of-date.
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Quick Reference

Prospector tab: <drawing-name>  ➤ 

<object-collection>  ➤  Right-click <object-name>
Synchronize

Toolspace Short-
cut Menu

Drawing Right-click  ➤ Synchronize

Promoting References

Promote references to Autodesk Civil 3D objects that can be edited.

When a reference is promoted and becomes an object that can be edited, it is
no longer associated with the data shortcut.

You can promote references singularly or you can promote all references in a
drawing.

To promote a reference

1 In Toolspace, on the Prospector tab, expand the drawing node. Expand
the object collection (for example, Surfaces).

2 Right-click the reference object (it is marked with a  ). Click Promote.

NOTE When a reference is promoted, it is no longer associated with the data
shortcut.

To promote all references

■ Click General menu  ➤ Data Shortcuts ➤ Promote All Data References.

■ NOTE When references are promoted, the are no longer associated with the
data shortcuts.
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Quick Reference

General  ➤ Data Shortcuts ➤ Promote All Data
References

Menu

Toolspace Short-
cut Menu

Prospector tab: <drawing-name>  ➤ 

<object-collection>  ➤  Right-click <object-name>
 ➤ Promote

Managing Data Using Vault
You can use Autodesk Vault to group drawings, project objects, and
project-related files, managing their sharing among members of a project
team.

For information about installing Autodesk Vault, see the Autodesk Data
Management Server Installation Guide.

Autodesk Vault provides access control and file version control. Autodesk Civil
3D provides commands in the Prospector tree to create and access project
drawings and shared project data.

A project is displayed as a collection in the Prospector tree. To view projects
in the Prospector tree, you must select Master View from the list at the top of
the Prospector tab.

Project Drawings

A project contains a collection of project drawings. You can use folders to
organize the drawings within a project. A master copy of a project drawing is
maintained in a specified project within a Vault database, and only one person
can edit the master copy at a time. When the edited project drawing is updated
in the Vault database, a new version of the drawing is created. The icons
displayed next to a drawing in the Prospector tree indicate the status of your
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local copy of the drawing in relation to the master copy of the drawing in the
Vault database. For more information, see Project Item State Icons (page 19).

Project Objects and References

A project contains collections of project objects, including surfaces, alignments,
profiles, and pipe networks, that can be shared with others. All shared project
objects are listed in the project object collections in the Prospector tree. Project
members can create a read-only copy of a project object, called a reference, in
a drawing. This read-only copy of the project object’s geometry can be used
to perform labeling, design, analysis, or what-if tasks.

Multiple project members can create references to the same shared project
object.

Project Points

When using Vault, project management for Autodesk Civil 3D points is
handled differently from project management for other objects. For more
information, see Working with Vault Project Points (page 69).

Project Management Commands

The project management commands that are listed on Prospector shortcut
menus can vary depending upon several factors, including the following:

■ Whether or not you have logged into Vault from the Prospector tree.

■ The state (for example, checked-in or checked-out) of the selected project
item.

■ The location of the project item in the Prospector tree. For example, some
drawing-related commands are available at the Open Drawings collection
level, some are available at the Projects collection level, and some are
available at both levels.

■ Whether or not the selected drawing has been saved.

■ Any circumstances that make the operation invalid for the selected item.

The user information that is defined for you on the current Vault server also
affects the actions you are permitted to perform. For example, you might have
permission to get copies of project drawings, but not create project drawings.
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Project and Drawing Items in the Prospector Tree

The Master View of the Prospector tree contains three collections related to
drawings and projects: Open Drawings, Projects, and Drawing Templates.

NOTE To view all the collections in the Prospector tree, select Master View from
the list at the top of the Prospector tab.

■ Open Drawings. Lists open project and non-project drawings.

■ Projects. Lists the projects available to you after you have logged in to a
Vault server and a Vault database.

■ Drawing Templates. Lists the available drawing templates. For more
information, see Working with Drawing Templates.

Project Item State Icons

The project item state icons in the Prospector tree identify the state of a local
project drawing in relation to the master copy in the Vault database.

NOTE To display the project item state icons, click  at the top of the Prospector
tab.

The icons are displayed next to drawings that have been added to the project,
indicating the state of the drawing on your system (your local copy) in relation
to the latest version of the master copy of the drawing in the Vault database.

An icon that is displayed next to a project object (in a project object collection,
such as Surfaces or Alignments) indicates the state of the project object’s source
drawing.
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The project item state icons are shown in the following table:

MeaningIcon

If no icon is displayed, then the drawing has been added to the project,
but you do not have a local copy.

The drawing is available to be checked out, and the version of the
master copy in the Vault database matches your local copy.

The drawing is available to be checked out, but your local copy is
newer than the latest version in the Vault database. This usually means
that you made changes to the local copy without checking it out.

The drawing is available to be checked out, and your local copy is older
than the latest version in the Vault database.

The drawing is checked out to you, but you do not have a local copy
of the object.

The drawing is checked out to you, and the version of the drawing in
the Vault database matches your local copy.

The drawing is checked out to you, and your local copy is newer than
the latest version in the Vault database. This usually means that you
have made changes to the drawing since you checked it out.

The drawing is checked out to you, and your local copy is older than
the latest version in the Vault database.

The drawing is checked out to someone else, and you do not have a
local copy.

The drawing is checked out to someone else, and your local copy
matches the latest version in the Vault database.

The drawing is checked out to someone else, and your local copy is
newer than the latest version in the Vault database.
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MeaningIcon

The drawing is checked out to someone else, and your local copy is
older than the latest version in the Vault database.

The drawing is locked, and you do not have a local copy.

The drawing is locked, and your local copy matches the latest version
in the Vault database.

The drawing is locked, and your local copy is newer than the latest
version in the Vault database.

The drawing is locked, and your local copy is older than the latest ver-
sion in the Vault database.

When your drawing contains a reference to a shared object, and the local copy

of the source drawing becomes out-of-date,  is displayed next to the
drawing name in the Prospector project tree. This generally occurs when
someone adds a newer version of the project object’s source drawing to the
project.

Drawing Item State Icons

The drawing item state icons in the Prospector and Settings trees identify
whether an object is locked, is a reference, or is being referenced, as shown
in the following table:

NOTE To display the drawing item state icons, click  at the top of the
Prospector tab.

MeaningIcon

Object is locked.
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Object is being referenced by another object.

Object is a reference to an object in another drawing.

Drawing Item Modifier Icons

The drawing item modifier icons in the Prospector tree identify an object that
is out-of-date or violates constraints, and also identifies the state of a local
copy of a project object.

NOTE To display the drawing item modifier icons, click  at the top of the
Prospector tab.

The following table explains the meaning of the three individual drawing
item modifier icons:

MeaningIcon

The object is out-of-date or violates constraints.

The project object is more recent than the local copy.

The local copy of the project object no longer matches the project
version, which means that you have edited it.

The following table lists all combinations of the drawing item modifier icons:

Local Copy Has
Been Edited Relat-
ive to Project Ob-
ject

Project Object is
More Recent than
Local Copy

Object is Out-of-
Date or Violates
Constraints

Icon Displayed
in Drawing

NoNoNo

22 | Chapter 1   Managing Projects



Local Copy Has
Been Edited Relat-
ive to Project Ob-
ject

Project Object is
More Recent than
Local Copy

Object is Out-of-
Date or Violates
Constraints

Icon Displayed
in Drawing

NoNoYes

NoYesNo

NoYesYes

YesNoNo

YesNoYes

YesYesNo

YesYesYes

NOTE Some of the above icons are displayed only in the Points list view.

The Project Collection List Views

Use the list views displayed in the Projects collection to obtain information
about the drawings and shared objects in the project.

NOTE To view the Projects collection in the Prospector tree, select Master View
from the list at the top of the Prospector tab.

Click a collection in the Prospector tree Projects collection to display a list
view.
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If the selected item is a project, the following information is displayed in the
list view:

■ Project name

■ Description

■ User name of the person who created the project

■ Date the project was created

If the selected item is a collection or folder containing drawing files, the
following information is displayed in the list view:

■ Name

■ Version

■ User name of the person who created this version

■ Date checked in

■ Comment

If the selected item is a collection containing shared objects, the following
information is displayed in the list view:

■ Object name

■ Source drawing name

■ Description

For more information about changing the list view display, see Customizing
a List View.

Error Codes

Errors encountered during Vault project management commands are reported
in two ways.

If a single error is encountered during a project management operation, it is
displayed in a message box. If multiple errors occur during a single operation,
the resulting Vault error codes are displayed in the Event Viewer. For example,
if a drawing check-in operation fails, and then subsequent check-ins of
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dependent files also fail, the error codes for the related multiple failures are
displayed in the Event Viewer.

The following table lists the Vault error codes that can be displayed if a project
management command fails:

Error DescriptionGroup Code/Error Code

SysErrCodes

Error code is not valid or is unspecified.0

CoreErrCodes

Error creating the knowledge vault in
database.

100

Script to prime the database with its
schema failed.

101

Knowledge vault already exists in database.102

Attempt to create user in database failed.103

Error adding user role in database.104

Error removing user role in database.105

Error validating the principal as being a
secure principal (i.e. authenticated).

106

Principle requirement does not match.
Should be anonymous.

107

Requires new transaction, but transaction
was not created.

108

Error initializing knowledge vault in data-
base.

109
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Error DescriptionGroup Code/Error Code

Stored procedure cannot be found.110

Error getting relative resource path.111

File stream is null, so the crc code can't be
calculated

112

File is not readable, so the crc code can't
be calculated

113

Could not create (Knowledge)VaultMaster
Database

114

Could not create (Knowledge)VaultMaster
Database schema

115

Could not initialize (Knowledge)VaultMas-
ter Database tables

116

Failure during migrate of a KnowledgeVault117

Failure creating VultSys user for the DB118

Failure during migrate of KnowledgeVault-
Master

119

Failure updating the KnowledgeVaultMas-
ter stored procedures

120

Failure deleting the KnowledgeVaultMaster121

Failure updating user information122

Could not update EIDatabase table123

Failure moving the file store124

26 | Chapter 1   Managing Projects



Error DescriptionGroup Code/Error Code

Failure attaching a database125

Failure detaching a database126

Failure deleting a Vault127

Failure backing up128

Failure restoring129

Unable to determine the version of a
KnowledgeVault or Master

130

The database master login is invalid131

The directory is not empty132

The Knowledge Vault referenced doesn't
exist

133

There are Knowledge Vaults still attached.134

Failure activating a vault135

Failure deactivating vault. DB is probably
in use

136

One of the inputs to the service call is in-
correct.

137

Vault name is not allowed, most likely due
to illegal characters.

138

Specified folder is illegal.139
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Error DescriptionGroup Code/Error Code

Specified folder is already in use.140

Could not find global option.141

Could not find local option.142

Duplicate User Name143

Database error because an MDF or LDF file
with that name already exists.

144

Database is in use145

Cannot determine the migration steps.146

The specified path is too long.147

Incorrect vault category Id entered148

The vault's category does not support the
operation.

149

The KnowledgeVaultMaster referenced
doesn't exist

150

Not enough disk space to perform
Backup/Restore operation.

151

Cannot restore db files to a remote location152

Selected directory does not contain a valid
backup structure.

153

SecurityErrCodes
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Error DescriptionGroup Code/Error Code

Authentication Token is invalid.300

User name and/or Password is invalid, so
user cannot be authenticated.

301

User is not a member of the vault302

Invalid permissions for transaction303

User is disabled304

Vault database does not exist305

DocServiceErrCodes

Folder id is invalid.1000

Cannot get the latest version of file.1001

Cannot get file version.1002

File id is invalid.1003

Checkout latest file version failed.1004

Error checking in file version into database.1005

Error undoing check out of file version.1006

Bad version id when getting file version
dependents or dependencies by version
id.

1007

Cannot add file because file exists.1008
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Error DescriptionGroup Code/Error Code

Cannot add file (unspecified failure)1009

Cannot add folder because folder exists.1011

Cannot add folder (unable to create/make
new folder).

1012

Cannot get file (file id is invalid).1013

Cannot create/make version in database.1014

Cannot delete file version because of de-
pendencies.

1015

Cannot undo checkout because user is not
the same as user who checked out file.

1016

Cannot undo checkout because passed in
folder id is not the same folder that the file
was checked out from.

1017

Cannot check in file because the file is not
currently checked out

1018

Cannot check in file because the file is not
currently checked out by the same user.

1019

Cannot check in file because passed in
folder id is not the same folder that the file
was checked out from.

1020

Cannot check out the file because it is
already checked out.

1021

Circular dependency check failed.1022
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Error DescriptionGroup Code/Error Code

Cannot create folder in database.1023

Cannot get folder.1024

Cannot get root folder from the database.1025

File belongs to a library folder.1026

Folder is a library folder.1027

Cannot move file.1028

A file exists in the destination folder that
has the same name as the file that is being
moved from its source folder.

1029

Cannot share because a file already exists
in the destination folder with the same
name.

1030

Cannot rename the file because there was
some other unexpected error.

1034

Could not create property definition in
database.

1035

Cannot get all property definitions.1036

Cannot get all extended property defini-
tions.

1037

Property could not be added in database.1039

Big property could not be added in data-
base

1040
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Error DescriptionGroup Code/Error Code

Cannot get properties1041

Create folder rule-check failed: parent must
exist, for all but root

1042

Create folder rule-check failed: libs can only
have non lib parent if that parent is root.
Libs cannot have non-lib children.

1043

Request to share a file to a folder fails be-
cause of a concurrent request to share the
file to the same folder.

1044

Request to move a file to a folder fails be-
cause of a concurrent request to move the

1045

file to the same folder or because of a
concurrent request to move the file to an-
other folder

Request to create a folder fails because the
folder name is longer that 80 characters.

1046

Request to conditionally delete a file fails
because there are delete restrictions (file

1050

has dependent parent files, file is checked
out, or file is linked or attached to an item)

Request to unconditionally delete a file fails
because the are delete restrictions that

1051

cannot be overridden (file is linked or at-
tached to an item)

Request to delete a file failed for an unspe-
cified reason.

1052

Request to conditionally delete a folder fails
because there are delete restrictions on

1053
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Error DescriptionGroup Code/Error Code

one or more child files (file has dependent
parent files, file is checked out, or file is
linked or attached to an item)

Request to unconditionally delete a folder
fails because the are delete restrictions that

1054

cannot be overridden on one or more child
files (file is linked or attached to an item)

Request to delete a folder fails due to an
unspecified reason

1055

Occurs when either no parameters have
been set and a purge is attempted or when

1056

an attempt is made set invalid parameter
values.

Occurs when something goes wrong while
purging file iterations from the database,
or while deleting files from the file store

1057

If the Unique File Name Required Vault
option is ON, a request to Add or Checkin

1058

a file with the same name as a file already
existing in the Vault will fail with this error.

Occurs when an attempt to update a
Folder fails for an unspecified reason.

1059

Occurs when an attempt to update a
Folder Name fails because another Folder
with that name exists in the parent.

1060

Label ID is invalid1061

Label Name contains invalid characters1062
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Error DescriptionGroup Code/Error Code

Label Name already exists in vault1063

Cannot create label in database.1064

1065

No PropertyGroup with the given Id exists1066

A PropertyGroup with the specified name
already exists.

1067

The PropertyDefinitions to be assigned to
the PropertyGroup do not share the same
DataType.

1068

The PropertyGroup must be assigned
PropertyDefinitions

1069

Request to add a PropertyGroup failed for
an unspecified reason

1070

Request to update a PropertyGroup failed
for an unspecified reason.

1071

Request to delete a PropertyGroup failed
for an unspecified reason.

1072

An unknown error occurred.1073

Folder with the same name already exists
in the destination folder

1074

Folder being moved has descendent files
that are checked out.

1075
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Error DescriptionGroup Code/Error Code

Move folder rule-check failed: parent must
exist, for all but root

1076

Move folder rule-check failed: libs can only
have non lib parent if that parent is root.
Libs cannot have non-lib children.

1077

A null path or path with illegal characters
has been passed in.

1078

The full path of the folder is greater than
256 characters

1079

A null value has been passed in where null
values are not allowed.

1080

The date is out of range for the DB.The
date should be between 1-1-1753 and 12-
31-9999

1081

SerializeErrCodes

Exception passed to Encodable Exception
saying the object is null

1200

Vault Best Practices
Follow these recommendations to ensure success with project management
using Autodesk Vault.

Installing and Configuring Vault

The Autodesk Data Management Server Installation Guide contains detailed
recommendations for configuring your Vault installation.
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There are many ways to configure a Vault installation. A single server
configuration is recommended. The server component (the Autodesk Data
Management Server) is installed on one system and the client component is
installed on any system that needs to communicate with that server. The
server stores all master copies of data files, and the clients can access the files
stored on the server. For best performance, a dedicated server is recommended.

You have flexibility within this model to choose a configuration that suits
your requirements, based on criteria such as the number of users who must
share data, how your users are divided into design teams, and the amount of
project data you expect your users to generate. Refer to the Autodesk Data
Management Server Installation Guide for more details.

After Vault is installed, you will need to decide whether to create a single vault
(database) or multiple vaults on the server. It is important to understand that
data and folder mappings are limited to within a single vault, and cannot be
cannot be shared across vaults. For more information on the difference between
a single vault configuration and a multiple vault configuration, see Autodesk
Data Management Server Installation Guide.

Project Management Workflow

When using Vault, follow the same steps each time you begin a project.

1 Designate a Vault server and database for the project, and create the initial
project and the project folder structure in the database. For more
information, see Project Folders (page 37).

2 Create Vault user names and groups with appropriate project-related
access restrictions. For more information, see Controlling Access to Project
Data (page 38).

3 Identify project objects and develop a strategy for partitioning project
object data. For more information, see Partitioning Project Data (page
38).

4 Establish written procedures for project members who will create or access
project data. Make communication between project members a priority.
For more information, see Procedures and Communication (page 39).

5 As team members create project objects, make sure they store source
drawings and related data in the project database on the Vault server.

6 As project objects become available, make sure other team members access
project object data only by creating read-only copies (references) of project
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objects in drawings. Make sure that drawings requiring version control
are stored in the project database on the Vault server.

7 When a major milestone is reached, use the Vault Labelling feature to
tag the appropriate version of each project file. For more information,
see Labeling Project Milestones (page 44).

Project Folders

Any file (drawing or not) that is associated with a project, especially any file
that would benefit from version control, should be stored in the project.
Temporary files, such as preliminary design drawings, do not need to be stored
in the project.

There are few constraints placed on the project folder structure. A project’s
top level folder must be named with the project name. The project’s top level
folder should be created from within Autodesk Civil 3D (instead of Vault
Explorer) to ensure the proper creation of required project files.

NOTE In general, if a user creates a folder or project data from either Autodesk
Civil 3D or in Vault Explorer, he can delete it using Vault Explorer. For this reason,
it is recommended that all new projects be created by a system administrator. This
will prevent other users from advertently deleting a project and associated files.

All project drawings must be placed directly beneath the project folder. You
can (and should) define folders and subfolders at this level and place every
drawing within a folder.

Create a set of folders for storing project object source drawings, which are
drawings that contain project objects. Folder names might include: Surfaces,
Alignments, and Pipe Networks. You do not need to create a folder for point
database files. They are automatically stored directly beneath the main project
folder and are visible only to a system administrator.

Create a set of folders for drawings that reference project data, including
drawings that will be delivered to the client. You should store these drawings
in a logical folder structure that corresponds to your office practices and client
deliverables. Folders names might include: Sheet Sets, Plan Profile Sheets, and
Topo Drawings.

A project can also include files that are not drawings. Using Vault Explorer,
create folders for such files directly under the project folder. Possible folder
names might include: Proposals, Client Correspondence, and Contracts. You
can store and access the files in non-drawing folders using Vault Explorer.
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For ease of use, all projects should use consistent folder structure and folder
names.

Controlling Access to Project Data

You can control who can access and edit project drawings and master copies
of project objects.

To ensure a secure environment, define a separate Vault user account for each
person who will be accessing project data on the project server. Each account
requires a unique user name and password. For more information, see Creating
Vault User Accounts (page 43).

Vault allows you to control access to project files at several levels: user names,
groups, and projects. With careful planning, you can minimize the amount
of configuration required and create a flexible security system. It is
recommended that you control access to project files at the group level.

Create a different Vault group for each function performed by members of
your organization. For example, you could create a set of groups including:
Surveyors, whose members would create and edit master copies of data in a
folder such as EG Surfaces; Civil Engineers, whose members would usually
read (but not modify) data in the EG Surfaces folder, and would create and
edit master data in a folder such as Alignments; and Drafters, whose members
would generally read data but would not modify master copies of data.

In general, each team member should belong to only one group. To change
how someone accesses project files, move their user name from one group to
another. For more information see Creating Vault Groups (page 44).

Partitioning Project Data

You should divide your project data across multiple drawings using a strategy
that both protects data integrity and supports ease of access.

In Autodesk Civil 3D, there is one master copy of each project object (such as
a surface, alignment, profile, or pipe network), and that master copy is stored
in a source drawing that is stored in the project’s Vault database. There are
virtually no restrictions on how many project objects you can store in the
same drawing, but there are some factors you should consider.

A key determining factor in how you partition your project data is the ability
of team members to create and modify project data when they need to. Because
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only one person can edit a drawing at a time, placing the master copy of every
project object into the same drawing is too restrictive for a collaborative
environment. In general, spreading your project objects across many drawings
makes more sense than crowding many objects into fewer drawings.

For each project object, create a separate drawing that contains the geometry
of the project object and, if needed, related project objects. Consider placing
each surface in a separate drawing. At the very least, consider placing a key
surface, such as an existing ground surface, in its own drawing. You will
probably want to keep a project alignment in the same drawing with all its
profiles; however, you should avoid placing all your project alignments in the
same drawing.

The function of a drawing should match its content. If a drawing contains
the master copy of a surface object, that drawing shouldn’t also be a plan
profile sheet. Keep project object geometry in its own drawing and create
separate drawings for viewing and annotating read-only copies of the geometry.

It is important to understand that a single project must contain all the data
that is required for that project. A drawing cannot contain references to more
than one project at a time.

Adhering to a consistent naming convention will make the drawings that
contain master copies of project objects easy to identify. Name a drawing that
contains a project surface with the same name as the surface; name a drawing
that contains a project alignment with the name of the alignment. Store
project drawings in appropriately named folders. For more information see
Project Folders (page 37).

Develop procedures that keep the number of shared project objects to a
minimum. Make sure that team members understand that when adding or
checking in a drawing, they should not share an object unless it is needed by
others. For more information, see Procedures and Communication (page 39).

Procedures and Communication

Establishing clear procedures and encouraging communication among team
members will prove beneficial during all phases of a project.

It is important to establish written procedures for use by team members who
will regularly access files using the Vault database. Procedures could include
instructions for logging onto the server and the project database, file and
folder naming conventions, and step-by-step instructions for adding and
modifying project drawings and objects. Procedures for adding and modifying
drawings could contain detailed guidelines describing, for example, when an
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object should be shared while checking in a drawing or when to check out
dependent files in addition to the drawing file.

Autodesk Civil 3D points and Survey points are handled differently from other
project objects. Establish separate procedures for team members who create,
access, or modify point or survey data. For more information see Working
with Vault Project Points (page 69) and Survey Database.

Communication between team members is helpful in any collaborative
environment. A mechanism (formal or informal) for informing other team
members of significant events, such as the creation of a new project object,
is recommended. Encourage team members to communicate anything that
might affect others. For example, a team member who intends to check out
a drawing for an extended period of time might notify other team members
as a courtesy.

Working with XREFs, DWFs, and Image Files

The External References palette (Xref Manager) in AutoCAD organizes, displays,
and manages externally referenced files, such as drawing Xrefs, DWFs, and
image files. The AutoCAD Vault plug-in, which you would install if you wanted
to run only AutoCAD and Vault, but not Autodesk Civil 3D, allows you to use
the External References palette to store and access files in Vault.

In Autodesk Civil 3D, files in a Vault database are not directly accessible from
the External References palette. However, the project management commands
in the Prospector tree provide the same Vault functionality (such as checking
in and checking out files) as the AutoCAD Vault plug-In.

If you are accustomed to using the External References palette with the
AutoCAD Vault plug-in to attach an external reference file that exists in a
Vault database, you should understand that the process requires an extra step
when using Autodesk Civil 3D project management. With the AutoCAD Vault
plug-in, you can use the External Reference palette to attach an external
reference file that exists in Vault, and the file is automatically copied to the
working folder. In Autodesk Civil 3D, you must use the Get Latest Version
command to create a local copy of the file before you can use the External
References palette to attach it to a drawing.

The above-described process creates a local copy of an externally referenced
file for each user who attaches it to a drawing. If you have a very large file,
you might want to manage it outside of Vault to minimize the number of
local copies that are required. To manage an externally referenced file outside
of Vault, place the file in a static network shared folder, where all team
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members can access it the way they would in a non-project environment. You
might also want to maintain a master copy of the file in the Vault database
for security and version control.

Data Shortcuts

Data shortcuts are a good collaborative tool for use outside of Autodesk Vault,
but they cannot be used with any drawing that is checked in to Vault.

You can consider using data shortcuts for preliminary designs, temporary
documents, or small projects that will always remain outside of Vault. However,
if you begin a project using data shortcuts, switching to the use of Vault
requires you to rebuild all object references.

To switch from using data shortcuts to using Vault, follow these general steps:

1 Remove all references to all data shortcuts from your drawings.

2 Add each data shorcut’s source drawing to the project, and share the
project objects contained within the drawing.

3 Re-create all the data shortcut references in your drawings using Vault
object references.

Working with Vault
In Autodesk Civil 3D 2007, you can manage project files using Autodesk Vault.

Autodesk Vault is a document management system, and in Autodesk Civil
3D, project objects are managed using drawing documents (.dwg files). Vault
provides access control and version control for all project drawings. One master
copy of each project drawing is maintained in the project database. Other
team members can reference the master copy, and they are notified when the
master copy is updated.

It is not necessary for all team members to know how to use Vault Explorer,
in fact most team members will access all required Vault features using the
Prospector tree. However, you will need a knowledgeable system administrator
who installs the server and client Vault software, uses Vault Manager or Vault
Explorer to customize Vault for your purposes, and regularly performs system
administration tasks such as data backups. Most of the topics in this section
are geared toward your system administrator.
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NOTE Some tasks, such as managing user accounts, can be done with either Vault
Explorer or Vault Manager. When Help suggests using Vault Explorer to perform
a task, you can often use Vault Manager instead.

Running Vault Explorer from the Prospector Tree

You can access Vault Explorer from the Prospector tree.

You must log in to Vault from the Prospector tree before you can run Vault
Explorer from the Prospector tree.

To run Vault Explorer from the Prospector tree

1 In Toolspace, on the Prospector tab, right-click the Projects collection.

2 Click Vault Explorer.

3 If the Welcome dialog box is displayed, click Log In.

4 In the Log In dialog box, enter your Vault user name.

5 Enter your password.

6 Select a Vault server.

7 Select a Vault database. Click  to list available databases.

8 Click OK.

Quick Reference

Prospector tab (Master View): right-click Projects
collection  ➤ Vault Explorer

Toolspace Short-
cut Menu

Project Files Created in a Project Database

When an Autodesk Civil 3D project is created, a initial set of empty or
near-empty files is created in the project database.
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The files are visible only to an administrator. Data is added to these files as
you add drawings and data to the project.

Project.xml

This file contains information about the project and the shared project objects.
The presence of this file is what indicates to Autodesk Civil 3D that the folder
containing this file is an Autodesk Civil 3D project folder. Do not delete,
modify, or move this file.

PointsGeometry.mdb

This file contains the project’s point geometry. The points contained in the
file are listed in the project’s Points list in the Prospector tree. This file is not
checked in and out directly as project drawing files are; it is checked in and
out indirectly when users use point access control commands.

PointsStatus.mdb

This file contains access control information about the points in
PointsGeometry.mdb, including the status (checked-in, checked-out, or
protected) of individual points.

Survey.sdb

This file represents the project survey database. For more information, see
Survey Database.

Creating Vault User Accounts

Each team member must have a user account on the project Vault server before
using project management commands.

To ensure a secure environment, define a separate Vault user account for each
person who will be accessing project data on the project server. Each account
requires a unique user name and password.

NOTE Each instance of a Vault Data Management server has a separate set of user
accounts. If a user requires access to multiple servers, you must define an account
for him on each server.

Only a user with administrator privileges can add a user. When you add a new
user to a server, you can specify a role for the user, which defines how the user
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will access data on the server. Autodesk Civil 3D project management supports
administrator, editor, and consumer roles for user accounts.

In general, you will find managing access to project data easier to control at
the group level, instead of at the individual user level. When you create a user
account, specify a role for each user that gives them the highest level of access
they require to any part of the database. For more information, see Creating
Vault Groups (page 44).

To add a new user in Vault Explorer, click Tools ➤ Administration and then
use the Security tab to add a new user. For more information, see Vault Explorer
Help.

Creating Vault Groups

Use Vault groups to manage and control access to project files.

Use Vault Explorer to add a group to a Vault server. Only a user with
administrator privileges can add a group.

When you create a group, you specify generally how the group’s members
should access project data by assigning the group the role of data editor, which
means that members of the group can add or edit data, or data consumer, which
means the group members can only read data, not edit it.

In general, a user should belong to only one group. To change someone’s
access to project files, move their user name from one group to another.

To add a group in Vault Explorer, click Tools ➤ Administration and use the
Security tab to add the group. You can add users to a group at this time. For
more information, see Vault Explorer Help.

Labeling Project Milestones

You can use the Vault labeling feature to identify a set of project files as a
grouping that defines a project milestone.

When a major project milestone is reached, you can label the files involved
so they can be easily identified. When you create a label, the most recently
checked-in version of every file in the project is assigned that label.

Labeling does more than just tag a set of files. If you later need to archive or
retrieve the set of files, you can do so. Labels do not include folder information;
only the project files are labeled.
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To create a label, right-click a project folder and click New Label. For more
information on creating and viewing labels, see Vault Explorer Help.

Project Administration

Your system administrator can use Vault Manager or Vault Explorer to
customize Vault for your purposes and to regularly perform project
administration tasks on an on-going basis.

These tasks include the following:

■ Creating, modifying, or deleting folders in a project

■ Deleting a project

■ Modifying the state of a file, for example, checking in a file that for some
reason cannot be checked in by the person who originally checked it out

■ Restoring a file back to a prior version

■ Backing up project files

For more information, see Vault Manager Help and Vault Explorer Help.

Pack and Go

Use the Vault Pack and Go feature to hand off project data to someone else.

Pack and Go resolves file dependencies for a drawing. This feature can be used
to supply copies of project files to someone. It is not intended for making
copies of project files that you want to edit and then return to the project.

For example, if your firm begins a project by doing a survey, creating the base
map, and completing the parcel layout, and then passes the drawing and
associated data to a civil engineer who completes the job, you could use Pack
and Go in Vault Explorer to assemble the information related to the drawing
before you hand it off.

For more information, see Vault Explorer Help.
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Working with Vault Projects
An Autodesk Civil 3D project groups all the drawings and data for a single
project in one place and controls access to all project files.

After you log in to a Vault server and a Vault database, the Projects collection
in the Prospector tree lists all the projects that are available to you.

NOTE You must select Master View from the list at the top of the Prospector tab
before you can view the Projects collection.

Logging in to a Vault Server

Before you can create or access project data, you must log in to a Vault server
and a Vault database from the Prospector tree.

You must be an authorized user on the server before you can log in. The server
and the database that you select when you log in determines what projects
you can access.

Before you log in, project management commands are not available on shortcut
menus in the Prospector tree. After you log in, the projects available in the
specified server and Vault database are listed in the Prospector tree, and
applicable project management commands are displayed on the menus when
you right-click a project item in the Prospector tree.

To log in to Vault from Prospector

1 In Toolspace, on the Prospector tab, select Master View from the list at
the top of the Prospector tab.

2 Right-click the Projects collection.

3 Click Log In.

4 In the Log In dialog box, enter your Vault user name.

5 Enter your password.

6 Select a Vault server.

7 Select a Vault database. Click  to list available databases.

8 Optionally, select Automatically Login Next Session.
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9 Click OK.

Quick Reference

Prospector tab (Master View): right-click Projects
collection  ➤ Log In

Toolspace Short-
cut Menu

Dialog Box Log In Dialog Box

Changing the Working Folder

The working folder maps your local copies of project files to the master copies
of project files in the Vault database.

You specify a default working folder name when you install Autodesk Civil
3D.

The working folder contains your local copies of files for all the projects stored
in a Vault database. If all your projects are stored in the same Vault database,
you will use the same working folder for all projects. If you work with projects
that are stored in different Vault databases, use a different working folder for
each Vault database.

In general, you should not change your working folder in the middle of an
Autodesk Civil 3D session. The working folder is used to determine the state
of your local copies of files in relation to the master copies of files in the project
database. If you change working folders, you will need to update your local
copies of the project files for the comparison between your local files and the
master copies to be accurate.

To change the working folder

1 In Toolspace, on the Prospector tab, right-click the Projects collection.

2 Click Properties.

3 In the Properties Civil 3D Projects dialog box, under Working Folder,

click  .

4 In the Browse For Folder dialog box, browse to the folder and click OK.
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Quick Reference

Prospector tab (Master View): right-click Projects
collection  ➤ Properties

Toolspace Short-
cut Menu

Dialog Box Properties Civil 3D Projects Dialog Box

Creating Projects

You can use the Prospector tree to create a new project in the project database.

In general, if a user creates a folder or project data from Autodesk Civil 3D or
in Vault Explorer, he can delete it using Vault Explorer. For this reason, it is
recommended that all new projects be created by a system administrator. This
will prevent other users from inadvertently deleting a project and associated
files.

To create a project

1 In Toolspace, on the Prospector tab, right-click the Projects collection.

2 Click New.

3 In the Project Properties dialog box, enter a project name.

4 Optionally, enter a description.

5 Click OK.
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Quick Reference

Prospector tab (Master View): right-click Projects
collection  ➤ New

Toolspace Short-
cut Menu

Dialog Box Project Properties Dialog Box

Changing the Active Project

The active project is displayed in bold type in the Prospector tree. It is the
default project for the project management dialog boxes.

NOTE The active project is not displayed in the Select Projects To Display dialog
box.

To change the active project

1 In Toolspace, on the Prospector tab, expand the Projects collection and
right-click a project.

2 Click Set Active.

Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

right-click <project name>  ➤ Set Active
Toolspace Short-
cut Menu

Selecting Projects to Display

You can limit the number of projects that are listed in the Prospector tree.

The projects that are available to you are determined by the server and the
database that you are logged in to. By default, all projects that are available
in the database are listed in the Prospector tree under the Projects colllection.
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Reducing the number of projects that are listed in the Prospector tree will not
only reduce the amount of data you will see, but also can reduce the time
required to update the display of the tree.

You cannot turn off the display of the active project, and the name of the
active project is not listed in the dialog box.

To select projects to display

1 In Toolspace, on the Prospector tab, right-click the Projects collection.

2 Click Select Projects To Display.

3 In the Select Projects To Display dialog box, select the checkbox next to
the name of any project that you want listed in the Prospector Projects
collection.

NOTE The name of the active project is not included in the list.

4 Click  to select all the projects in the list.

5 Click  to clear all the projects in the list.

6 Click OK.

Quick Reference

Prospector tab (Master View): right-click Projects
collection  ➤ Select Projects To Display

Toolspace Short-
cut Menu

Dialog Box Select Projects To Display Dialog Box

Working When Disconnected

You can work with project files while you are disconnected from Vault.

If you are not connected to the network, in general, you can work with your
local copies of project drawings the way you normally do. However, you
cannot perform project management functions (such as checking in and
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checking out files), you cannot get updated versions of any project files, and
you cannot create new references to project objects while you are disconnected.

Before you disconnect, you should update your local copies of any project
files by getting the latest versions of any project files that you are working
with, including the source drawings for any project objects that your drawing
references.

Deleting a Project

Delete a project from the project database using Vault Explorer.

A project can be deleted by a system administrator or by the user that created
it. It is recommended that all projects be created by a system administrator
to protect projects from being inadvertently deleted by users who are not
system administrators.

To delete a project from the project database, delete the top-level project
folder. You cannot delete a file that is checked out.

After a project has been deleted from the Vault database, its name remains in
the Projects collection in the Prospector tree until you refresh the display of
the tree.

After the project has been deleted from the Vault database, use Windows
Explorer to delete local copies of project files and folders from the working
folder.

Migrating Old Autodesk Civil 3D Projects

You can easily migrate projects from earlier versions of Autodesk Civil 3D to
Autodesk Civil 3D 2007.

You must log in to Vault from the Prospector tree before the project migration
command is available.

To migrate an old Autodesk Civil 3D project

1 In Toolspace, on the Prospector tab, right-click the Projects collection.

2 Click Migrate Pre-Civil 3D 2007 Project.

3 In the Select Civil 3D Project Folder To Migrate dialog box, browse to the
project folder to be migrated.
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4 Select the folder that contains the project and click Open.

The new project is created on the Vault server in the database that you are
logged in to.

Quick Reference

Prospector tab (Master View)  ➤  right-click Projects
collection  ➤ Migrate Pre-Civil 3D 2007 Project

Toolspace Short-
cut Menu

Logging Out from Vault

Logging out from Vault terminates your connection with the Vault server and
the Vault database that you are logged in to.

After you log out, you can no longer view or access project data in Prospector.
When you end an Autodesk Civil 3D session, you are automatically logged
out.

To log out from vault

1 In Toolspace, on the Prospector tab, right-click the Projects collection.

2 Click Log Out.

Quick Reference

Prospector tab (Master View)  ➤  right-click Projects
collection  ➤ Log Out

Toolspace Short-
cut Menu

Working with Vault Project Drawings
Use drawings to create and access project data.

There is a tight association between a project object, such as a surface, and its
source drawing, which is the drawing that contains the object. To create a
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project object, add the object’s source drawing to a project and specify that
you want to share the object with others. You can edit a project object by
checking out the source drawing, making the change, and checking the source
drawing back in.

You can store any project drawing in the project database. You will find it
easier to keep your project organized if you use more than one folder to store
your project drawings. For more information, see Project Folders (page 37).

The Drawings collection in the Prospector tree is not a folder and does not
map to a folder in either the project database or the working folder. However,
the folders under the Drawings collection map directly to folders in the project
database and the working folder.

NOTE It is recommended that you do not maximize the drawing window when
working with Autodesk Civil 3D. Doing so can cause problems when you access
the Panorama window from a toolbar. For more information, see The Panorama
Window.

Adding a Drawing to a Project

You can add a drawing to a project to make the drawing available to others,
to place it under version control, and to create project objects from objects in
the drawing.

When you add a drawing to a project, you should add it to an appropriate
folder based on the drawing’s content and its function within the project. If
an appropriate folder does not exist, you can create one.

While adding a drawing to a project, specify which objects (if any) in the
drawing you want to share with others. Those objects are then added to the
appropriate Prospector project object collection (such as Surfaces, Alignments,
or Pipe Networks) and can be referenced by others.

NOTE You should only share objects that are required by others. If you are unsure
whether an object should be shared, do not share it. You can share it later using
the Check Out and Check In commands.

While adding a drawing to a project, you can specify that associated files,
including surface data files, image files, and XREFs, are added to the project.
You can also specify whether a .dwf file is created and added to the project
for display in drawing item views and Vault Explorer.
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If a drawing containing a surface is added to a project, and the surface
references external data files, a folder is created under the drawing to hold
those files. The files are placed in the folder, and the surface definition in the
drawing is updated to reflect the new (relative) location of the files.

An open drawing must be saved before you can add it to a project. A copy of
the drawing is created in your local working folder and the master copy is
added to the project.

To add a drawing to a project

1 In Toolspace, on the Prospector tab, expand the Open Drawings collection.

2 Right-click the drawing you want to add to the project.

3 Click Add to Project.

4 In the Add To Project 1 dialog box, select the project to which you want
to add the drawing.

5 Click Next.

6 In the Add To Project 2 dialog box, specify the location of the drawing

within the project. Click  to create a new folder.

7 Click Next.

8 In the Add To Project 3 dialog box, specify file dependencies and .dwf
creation options.

9 Click Next.

10 In the Add To Project 4 dialog box, specify which objects in the drawing
you want to share with others.

NOTE If the drawing does not contain objects that can be shared, this dialog
box is not displayed.

11 Click Finish.
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Quick Reference

Prospector tab: Open Drawings collection  ➤ 

right-click <drawing name>  ➤ Add to Project
Toolspace Short-
cut Menu

Add To Project 1 Dialog BoxDialog Box
Add To Project 2 Dialog Box
Add To Project 3 Dialog Box
Add To Project 4 Dialog Box

Checking a Drawing out from a Project

You can check out a project drawing to make changes to it.

Checking out a drawing prevents others from changing the drawing while
you are working on it. When you have completed your changes, check the
drawing in.

Check out a drawing only if you intend to make changes to it. If you do not
need to change the drawing, get a read-only copy using Get Latest Version.
For more information, see Getting the Latest Version of a Drawing (page 58).

You can check out files that the drawing is dependent on when you check
out the drawing. However, you should only check out dependent files if you
intend to change them.

When you check out a drawing, a local copy of the drawing is placed in your
working folder, and the drawing is opened.

To check a drawing out from a project

1 In Toolspace, on the Prospector tab, under the Projects collection, expand
the project collection and the project Drawings collection that contains
the drawing you want to check out.

2 Right-click the drawing and click Check Out.

3 In the Check Out Drawing dialog box, specify whether dependent files
should also be checked out.

4 Specify whether you want the latest version of the file.

Getting the latest version overwrites your local copy of the file with the
most recent version of the master copy of the file. Most of the time, you
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should get the latest version of the file. However, if you want to create a
new version of the file from your existing local copy, do not get the latest
version.

5 If Include File Dependencies is selected, specify which project files should
be checked out.

6 Click OK.

Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

project Drawings collection  ➤  right-click <drawing
name>  ➤ Check Out

Toolspace Short-
cut Menu

Dialog Box Check Out Drawing Dialog Box

Checking a Drawing in to a Project

After you check out a project drawing and change it, check in the drawing to
make it available to others and to update the version in the project database.

You can only check in a drawing that you have checked out. Checking in the
drawing returns the file to its original project database and folder and updates
the version. If the drawing is opened and has been changed, it is automatically
saved before it is checked in.

When checking in a project drawing, you can specify which objects in the
drawing (if any) you want to share with others. You can also specify whether
a .dwf file is created for display in drawing item views and Vault Explorer.

To check a drawing in to a project

1 In Toolspace, on the Prospector tab, under the Projects collection, expand
the project collection and the project Drawings collection that contains
the drawing you want to check in.

2 Right-click the drawing and click Check In.

3 In the Check In Drawing 1 dialog box, specify any file dependencies, .dwf
creations options, and comments.
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4 Click Next.

5 In the Check In Drawing 2 dialog box, specify which objects in the
drawing you want to share with others.

NOTE If the drawing does not contain objects that can be shared, this dialog
box is not displayed. Objects that were shared during the Add to Project
command or a previous Check In command are not listed.

6 Click Finish.

Quick Reference

Prospector tab (Master view): Projects collection  ➤ 

project Drawings collection  ➤  right-click <drawing
name>  ➤  Check In

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤ 

right-click <drawing name>  ➤  Check In

Dialog Box Check In Drawing 1 Dialog Box
Check In Drawing 2 Dialog Box

Opening a Project Drawing

After a drawing has been added to a project, open it from the Projects collection
in the Prospector tree.

If you want to open a project drawing and edit it, you must first check it out.
If you do not have the project drawing checked out, you can only open it in
read-only mode.

You can tell whether the drawing is checked out to you by the icon displayed
next to the drawing name in the Prospector tree. For more information, see
Project Item State Icons (page 19).

If the drawing you want to check out is a source drawing for a project object,
you can open it from the project object collection. For more information, see
Viewing Project Object Source Drawings (page 65).
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To open a project drawing

1 In Toolspace, on the Prospector tab, under the Projects collection, navigate
to the folder that contains the drawing you want to open.

2 Right-click the drawing.

3 Click Open or Open (read-only).

The command that is listed on the menu depends on whether or not you
have the drawing checked out.

Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

project Drawings collection  ➤  right-click <drawing
name>  ➤ Open

Toolspace Short-
cut Menu

Getting the Latest Version of a Drawing

You can obtain a read-only copy of the latest version of any project drawing.

Use the Get Latest Version command to update your copy of a source drawing
for a project object, a drawing that contains a reference to shared project
objects, or any other project drawing.

You can tell whether or not your local copy of a drawing is the latest version
available in Vault by the icon displayed next to it in the Prospector tree. For
more information, see Project Item State Icons (page 19).

The Get Latest Version command is displayed in the shortcut menu of a
Prospector tree item only when the local copy of the file is out-of-date or does
not exist. The command is not available for an open drawing.

When applicable, the Get Latest Version command is available at every level
within the Prospector Projects collection. If you select the command at a level
that contains folders beneath it, you can choose which folders you want to
update.
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To get the latest version of a drawing

1 In Toolspace, on the Prospector tab, under the Projects collection,
right-click the drawing, collection, or folder you want to update.

2 Click Get Latest Version.

3 In the Get Latest Version dialog box, select Include File Dependencies to
display any dependent files in the Project Files list.

4 Clear the checkboxes next to files and folders that you do not want
updated.

5 Click OK.

Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

right-click collection, folder, or item  ➤ Get Latest
Version

Toolspace Short-
cut Menu

Dialog Box Get Latest Version Dialog Box

Resetting a Checked out Drawing

If you have a project drawing checked out, you can reset it to a checked-in
state without making any changes to it.

A drawing must be checked out to you before you can reset its state. The Undo
Check Out command resets your local copy of the drawing back to the latest
version of the file in the project database, which means that any changes you
made to the drawing are lost. You can preserve the changes you made to the
drawing by saving and renaming the drawing (using SaveAs) before using the
Undo Check Out command.

The status of the drawing in the project database is reset to checked-in, and
the file version is not updated.
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To undo the check out of a drawing

1 In Toolspace, on the Prospector tab, under the Projects collection, expand
the project collection and the project Drawings collection that contains
the drawing you want to reset.

2 Right-click the checked-out drawing.

3 Click Undo Check Out.

4 In the Undo Check Out dialog box, select Include File Dependencies to
display dependent files.

5 If dependent files are displayed, clear the checkboxes next to files that
should remain checked-out.

6 Click OK.

Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

project Drawings collection  ➤  right-click <drawing
name>  ➤ Undo Check Out

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤ 

right-click <drawing name>  ➤ Undo Check Out

Dialog Box Undo Check Out Dialog Box

Synchronizing Drawing Data with Project Data

You can update an open drawing with the latest versions of all project objects
and point data.

The Sync To Project command updates out-of-date drawings that reference
project objects. It also updates any out-of-date project points contained in the
drawing. The out-of-date condition can occur when someone checks in a
project object’s source drawing or checks in project points.

Local copies of out-of-date source drawings and project points are replaced
with the latest version from the project database.
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To synchronize a drawing

1 In Toolspace, on the Prospector tab, under the Open Drawings collection,
right-click the drawing you want to synchronize.

2 Click Sync To Project.

3 In the Sync To Project dialog box, select the out-of-date project objects
you want synchronized.

4 Click OK.

Quick Reference

Prospector tab: Open Drawings collection  ➤ 

right-click <drawing name>  ➤ Sync to Project
Toolspace Short-
cut Menu

Sync To Project Dialog BoxDialog Box

Detaching a Drawing from a Project

You can detach a drawing from a project to sever the connection between the
drawing and all project data.

WARNING When you detach a drawing from a project, all links to project source
drawings and project data are severed and cannot be re-established.

A drawing must be open to be detached from a project. When you detach a
drawing from a project, all references in the drawing to shared project objects
are replaced with object data that can be edited.

When a drawing contains a project object, such as a reference to a project
surface, the project object is promoted to a surface object that has no reference
back to the original source drawing that its geometry it based on. You can edit
the promoted surface, but you cannot rebuild it based on the original source
data.

To detach a drawing from a project

1 In Toolspace, on the Prospector tab, in the Open Drawings collection,
right-click the drawing you want to detach.
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2 Click Detach Project.

Quick Reference

Prospector tab: Open Drawings collection  ➤ 

right-click <drawing name>  ➤ Detach Project
Toolspace Short-
cut Menu

Working with Vault Project Objects
You can create, manage, and reference project objects through their source
drawings.

A project object is an object that is intended to be shared with others working
on a project. A project object is managed through its source drawing, which is
the drawing that contains the object.

A project object becomes available to others when the source drawing
containing the object is added to or checked in to the project database and
the object is selected to be shared.

To include a project object in another drawing, you create a reference to the
object. A reference is a read-only copy of the object that you can refer to as if
it were the object itself.

Creating Project Objects

Create a project object by adding a source drawing to a project.

When you add or check in a drawing to a project, you can specify which
objects (such as surfaces) in the drawing are to be shared. For more information,
see Adding a Drawing to a Project (page 53) and Checking a Drawing in to a
Project (page 56).

After a project object has been shared, it is listed in the project’s object
collection (such as Surfaces, Alignments, or Pipe Networks) in the Prospector
tree.

You can access a project object’s data in another drawing by creating a
read-only copy called a reference. For more information, see Creating
References to Project Objects (page 63).
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Creating References to Project Objects

Include a read-only copy of a project object in a drawing by creating a reference
to it.

All the available project objects in a project are listed in the project’s object
collections, including Surfaces, Alignments, and Pipe Networks, in the
Prospector tree.

You access a project object’s data in a drawing by creating a reference to it. A
reference is a read-only copy of an object. When you create a reference to an
object, you cannot modify the object’s geometry, but you can access its
properties and data, apply styles and annotation, and perform some types of
analysis.

Creating a reference creates a local copy of the object’s source drawing in your
working folder. If you already have a local copy of the object’s source drawing,
it is updated to the latest version, if necessary.

To create a reference to a project object

1 Open the drawing to which you want to add the reference, and make it
the active drawing.

2 In Toolspace, on the Prospector tab, expand the Projects collection.

3 Expand the project collection that contains the project object.

4 Expand the object collection that contains the project object.

5 Right-click the project object.

6 Click Create Reference.

7 In the Create Reference dialog box for the object, specify how the object’s
geometry will be displayed in the drawing.

8 Click OK.
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Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

<project> collection  ➤  <object> collection  ➤ 

right-click <object>  ➤ Create Reference

Toolspace Short-
cut Menu

Getting the Latest Version of Project Objects

If someone makes a change to a project object, you can easily update your
local copy of the object’s source drawing.

When someone creates a new version of a project object’s source drawing in
the project database, your local copy becomes out-of-date. You can determine
the state of your local copy by the icon displayed next to either the source
drawing or the project object in the Prospector tree. For more information,
see Project Item State Icons (page 19).

NOTE The Get Latest Version command is available at all levels of a project in the
Prospector tree, when applicable.

To get the latest version of a project object

1 In Toolspace, on the Prospector tab, expand the Projects collection.

2 Expand the project collection that contains the project object.

3 Expand the object collection that contains the project object.

4 Right-click the project object and click Get Latest Version.

5 In the Get Latest Version dialog box, select Include File Dependencies to
display dependent files in the Project Files list.

6 Clear the checkboxes next to files and folders that you do not want
updated.

7 Click OK.
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Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

<project> collection  ➤  <object> collection  ➤ 

right-click <object>  ➤ Get Latest Version

Toolspace Short-
cut Menu

Dialog Box Get Latest Version Dialog Box

Viewing Project Object Source Drawings

You can quickly open or switch to a project object’s source drawing.

You can open a project object’s source drawing from the project object level
in the Prospector tree. If the drawing is already open, you can make it the
active drawing.

NOTE If you do not have the drawing checked out, you can only open the drawing
in read-only mode.

To access a source drawing for a project object

1 In Toolspace, on the Prospector tab, expand the Projects collection.

2 Expand the project collection that contains the project object.

3 Expand the object collection that contains the project object.

4 Right-click the project object and do one of the following:

■ If you have the source drawing checked out, click Open Source
Drawing to open it.

■ If you do not have the source drawing checked out, click Open Source
Drawing (Real-only) to open it.

■ If the drawing is open, click Switch To Source Drawing to make it the
active drawing.
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Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

<project> collection  ➤  <object> collection  ➤ 

right-click <object>  ➤ Open Source Drawing

Toolspace Short-
cut Menu

OR
Prospector tab (Master View): Projects collection  ➤ 

<project> collection  ➤  <object> collection  ➤ 

right-click <object>  ➤ Open Source Drawing
(Read-only)
OR
Prospector tab (Master View): Projects collection  ➤ 

<project> collection  ➤  <object> collection  ➤ 

right-click <object>  ➤ Switch To Source Drawing

Checking Out Project Object Source Drawings

You can check out a project object’s source drawing at the project object level
in the Prospector tree.

When you check out a drawing, a local copy of the drawing is placed in your
working folder, and the drawing is opened.

To check out a project object’s source drawing

1 In Toolspace, on the Prospector tab, expand the Projects collection.

2 Expand the project collection that contains the project object.

3 Expand the object collection that contains the project object.

4 Right-click the project object and click Check Out Source Drawing.

5 In the Check Out Drawing dialog box, specify whether file dependencies
should be included.

6 Specify whether the latest version of the file is desired.

7 If Include File Dependencies is selected, specify which project files should
be checked out with the drawing file by selecting the checkboxes next
to them.

8 Click OK.
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Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

<project> collection  ➤  <object> collection  ➤ 

right-click <object>  ➤ Check Out Source Drawing

Toolspace Short-
cut Menu

Check Out Drawing Dialog BoxDialog Box

Resetting a Checked Out Source Drawing

You can undo the check out of a project object’s source drawing at the project
object level in the Prospector tree.

To undo the check out of a project object’s source drawing

1 In Toolspace, on the Prospector tab, expand the Projects collection.

2 Expand the project collection that contains the project object.

3 Expand the object collection that contains the project object.

4 Right-click the project object and click Undo Check Out Source Drawing.

5 In the Undo Check Out dialog box, select Include File Dependencies to
display dependent files.

6 If dependent files are displayed, clear the checkboxes next to files that
should remain checked out.

7 Click OK.
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Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

<project> collection  ➤  <object> collection  ➤ 

Toolspace Short-
cut Menu

right-click <object>  ➤ Undo Check Out Source
Drawing

Undo Check Out Dialog BoxDialog Box

Promoting Project Objects

You can replace a read-only object reference with an editable copy of the
project object by promoting the object reference.

WARNING Promoting an object reference severs all connections to project object
source data. The connection cannot be re-established.

You should promote an object reference only when you have no need to
maintain the project object’s link to its source drawing or data.

To promote a project object

1 In Toolspace, on the Prospector tab, under the Open Drawings collection,
expand the drawing that contains the project object you want to promote.

2 Expand the drawing object collection that contains the object reference
you want to promote.

3 Right-click the object and click Promote.
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Quick Reference

Prospector tab: Open Drawings collection  ➤  <object>
collection  ➤  right-click <object>  ➤ Promote

Toolspace Short-
cut Menu

Working with Vault Project Points
Project management for Autodesk Civil 3D points differs from project
management for other project objects.

Master copies of points are stored in a point database, not a source drawing,
and points are checked out or copied directly to a drawing. The project points
in a drawing are usually a subset of the project database. Individual points are
not displayed in the project database, and they cannot be viewed using Vault
Explorer.

Project points are accessed and managed through two files that are stored in
the project database with other project files: PointsGeometry.mdb, which is the
project point database, and PointsStatus.mdb, which contains information
about the status (for example, checked-in or checked-out) of individual points.
You do not explicitly check out or check in the project point database. Instead,
you check out, modify, and check in individual project points and the project
point database is updated automatically.

The status of your local project points in relation to the latest version of the
project point database in the project’s Vault database is shown by the icon
displayed next to the project Points node under the project collection. The
icons that can be displayed are shown in the following table:

MeaningIcon

If no icon is displayed, the project point database exists in the project’s
Vault database, and you have not accessed it.

The local project point database matches the latest version of the project
point database in the project’s Vault database.

The local project point database is newer than the latest version of the
project point database in the project’s Vault database.
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MeaningIcon

The local project point database is older than the latest version of the
project point database in the project’s Vault database.

Many of the project management operations (such as check in and check out)
that can be performed on points in a drawing can also be performed using
point groups.

Project Point State Icons

Because Vault is not used for managing individual points, the icons indicating
the state of individual points (for example, checked-in or checked-out) are
different from the icons used for other project objects.

The following table shows the project point state icons, which are displayed
in the Points list view.:

MeaningIcon

The point is checked in.

The point is checked out to your active drawing.

The point is checked out to a drawing other than your active drawing.
This could be a drawing that belongs to you or to someone else.

The point is protected and cannot be changed.

The Project Points List View

You can use the project points list view to obtain information about the state
of project points.

70 | Chapter 1   Managing Projects



NOTE To view project points in the Prospector tree, select Master View from the
list at the top of the Prospector tab.

Under the Prospector Projects collection, click the project Points collection
to display a list view that lists all of the project points. Project management
information is listed, including:

■ Most recent version number

■ User who last modified the point and the date it was modified

■ Current state of the point (checked-in, checked-out, or protected) and the
date the state was last changed

■ User who set the current state of the point

■ If checked-out, the drawing and host computer that the point is checked
out to

Project point state icons are displayed next to each point. For more
information, see Project Point State Icons (page 70).

For more information about changing the list view display, see Customizing
a List View.

Working with Point-related Project Management
Commands

You can perform point access control operations, such as checking in and
checking out points, in several locations in the Prospector tree.

When you select multiple points and perform a project management operation
on them, the operation is performed only on those points to which it applies.
For example, if you select a list of points in the Points list view and use the
Check In command to check them in, only the points you checked out are
checked in.

In addition, Survey points that are created using the Prospector Survey tab are
not included in project management commands even if they are selected. For
example, any Survey points included in the selection list during the Add to
Project command are not added to the project.
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You can access point-related project commands using list view shortcut menus
or using point groups, as described below:

■ If you already have a copy of a project point in a drawing, use the shortcut
menu in the Prospector drawing Points list view to check in, check out,
protect, or get a copy of the point.

■ If you do not have a copy of the point in a drawing, use the shortcut menu
in the Prospector project Points list view to check in, check out, protect,
or get a copy of a point.

■ If you have point groups defined in the drawing, right-click a point group
in the Prospector tree and use the point group shortcut menu to check in,
check out, protect, or get copies of project points.

In some cases, only valid project management commands are displayed on a
shortcut menu. For example, if a set of points are not available for check out,
the Check Out command might not be displayed, but the Get From Project
command would be displayed so that you can get a read-only copy of the
point. In some cases, a drawing must be saved before project management
commands are available.

Adding Points to a Project

You can use the Add To Project command to add points to a project so they
can be accessed by others.

You can add some or all of the points in a drawing to a project. Before you
can add drawing points to a project, you must save the drawing. If the drawing
has not been saved, the Add to Project command is not available.

If the drawing contains one or more project objects, the points are added to
the project that the existing project objects belong to. If the drawing does not
contain project objects, you are prompted to select a project.

You can access the Add To Project command not only from the drawing’s
Points list view, but also from a drawing point group’s shortcut menu.

To add points to a project

1 In Toolspace, on the Prospector tab, under the Open Drawings collection,
expand the drawing that contains the points you want to add to the
project.

2 Click the Points collection to display the Points list view.
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3 In the list view, select the points, right-click, and click Add To Project.

Any Survey points included in the selection are not added to the project.
Survey points are stored only in the project’s Survey Point database.

4 If you are prompted, select a project to add the points to.

5 In the Add To Project dialog box, enter a comment.

6 From the Check In Options list, select an option to specify the state of
the points after you add them to the project.

7 Click OK.

Quick Reference

Prospector tab: Open Drawings collection  ➤  click
Points collection  ➤  right-click selected points in list
view  ➤ Add To Project

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤ Point
Groups collection  ➤  right-click <point group>  ➤ Add
Points To Project

Dialog Box Add To Project Dialog Box

Checking Out Points

You can use the Check Out command to prevent others from making changes
to project points while you are editing them.

To edit a project point, check it out to a drawing, edit it in the drawing, and
then check it back into the project.

NOTE When working with project points, the term local copy refers to the copy
of the point in your drawing.

Checking out a project point creates a local copy of the point in the drawing.
The Check Out command gives you exclusive access to the project point; no
one else can check it out while you are working on it.
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If the Check Out command is not available, you can use the Get From Project
command to a read-only local copy of the point. For more information, see
Copying Project Points into a Drawing (page 76).

To check out project points

1 Verify that the drawing you want to bring the points into is the active
drawing. If it is not, right-click the drawing name in the Open Drawings
collection in the Prospector tree and click Switch To.

2 In Toolspace, on the Prospector tab, expand the Projects collection and
then expand the project that contains the points you want to check out.

3 Click the project Points collection to display a list view.

4 In the list view, select the project points you want to check out, right-click,
and click Check Out.

5 In the Check Out dialog box, click OK.

Local copies of the points are created in the active drawing.

Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

project Points collection  ➤  right-click selected points
in list view  ➤ Check Out

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤ Point
Groups collection  ➤  right-click <point group>
 ➤ Check Out Points

Dialog Box Check Out Dialog Box

Checking In Points

You can use the Check In command to check in checked-out project points.

NOTE When working with project points, the term local copy refers to the copy
of the point in your drawing.
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After you edit one or more project points, use the Check In command to
replace the existing project point with your local copy of the project point,
and increase the project point’s version number.

The Check In command always updates the project point from the drawing
that the point was checked out to.

To check in project points

1 Verify that the drawing that you want to check the points in from is the
active drawing. If it is not, right-click the drawing name in the Open
Drawings collection in the Prospector tree and click Switch To.

2 Click the drawing’s Points collection to display a list view.

3 In the list view, select the points to check in and right-click.

4 Click Check In.

5 In the Check In dialog box, enter a comment.

6 From the Check In Options list, select an option to specify the state of
the points after you check them in.

7 Click OK.
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Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

project Points collection  ➤  right-click selected points
in list view  ➤ Check In

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤  drawing
Points collection  ➤  right-click selected points in list
view  ➤ Check In
OR
Prospector tab: Open Drawings collection  ➤ Point
Groups collection  ➤  right-click <point group>
 ➤ Check In Points

Dialog Box Check In Dialog Box

Copying Project Points into a Drawing

You can use the Get From Project command to make a read-only copy of
project points in a drawing.

To copy project points into a drawing

1 Verify that the drawing to which you want to copy is the active drawing.
Right-click the drawing name in the Prospector tree and click Switch To.

2 In Toolspace, on the Prospector tab, expand the Projects collection and
then expand the project collection that contains the points you want to
copy.

3 Click the project Points collection to display the list view.

4 In the list view, select the points to copy, right-click, and click Get From
Project.

5 In the Get From Project dialog box, click OK.

76 | Chapter 1   Managing Projects



Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

project Points collection  ➤  right-click selected points
in list view  ➤ Get From Project

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤  drawing
Points collection  ➤  right-click selected points in list
view  ➤ Get From Project
OR
Prospector tab: Open Drawings collection  ➤ Point
Groups collection  ➤  right-click <point group>  ➤ Get
Points From Project

Dialog Box Get From Project Dialog Box

Protecting Project Points

You can use the Protect command to prevent project points from being checked
out and edited.

You cannot protect a project point that is checked-out.

To protect project points

1 In Toolspace, on the Prospector tab, expand the Projects collection and
then expand the project collection that contains the points you want to
protect.

2 Click the project Points collection to display the list view.

3 In the list view, select the points to protect, right-click, and click Protect.

4 In the Protect dialog box, click OK.

A lock icon  is displayed next to a protected project point in the Points
list view.
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Prospector tab (Master View): Projects collection  ➤ 

project Points collection  ➤  right-click selected points
in list view  ➤ Protect

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤  drawing
Points collection  ➤  right-click selected points in list
view  ➤ Protect
OR
Prospector tab: Open Drawings collection  ➤ Point
Groups collection  ➤  right-click <point group>
 ➤ Protect Points

Dialog Box Protect Dialog Box

Unprotecting Project Points

You can use the Unprotect command to allow protected project points to be
checked out and edited.

Only the person who protected a project point can unprotect it.

A lock icon  is displayed next to a protected point in the Points list view.

To unprotect project points

1 In Toolspace, on the Prospector tab, expand the Projects collection and
then expand the project collection that contains the points you want to
unprotect.

2 Click the Points collection to display the list view.

3 In the list view, select the protected points, right-click, and click
Unprotect.

4 In the Unprotect dialog box, click OK.
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Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

project Points collection  ➤  right-click selected points
in list view  ➤ Unprotect

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤  drawing
Points collection  ➤  right-click selected points in list
view  ➤ Unprotect
OR
Prospector tab: Open Drawings collection  ➤ Point
Groups collection  ➤  right-click <point group>
 ➤ Unprotect Points

Dialog Box Unprotect Dialog Box

Deleting Project Points

You can use the Delete From Project command to delete project points.

When you delete a project point, it is permanently removed from the project,
and is no longer listed in the Prospector tree.

Before you can delete a project point, you must check it out. For more
information, see Checking Out Points (page 73).

To delete project points

1 In Toolspace, on the Prospector tab, expand the Projects collection and
then expand the project collection that contains the points you want to
delete.

2 Click the Points collection to display the list view.

3 In the list view, select the points to delete, right-click, and click Delete
From Project.

4 In the Delete From Projectdialog box, click OK.
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Prospector tab (Master View): Projects collection  ➤ 

project Points collection  ➤  right-click selected points
in list view  ➤ Delete From Project

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤  drawing
Points collection  ➤  right-click selected points in list
view  ➤ Delete From Project
OR
Prospector tab: Open Drawings collection  ➤ Point
Groups collection  ➤  right-click <point group>
 ➤ Delete Points From Project

Dialog Box Delete From Project Dialog Box

Resetting Points You Checked Out

You can use the Undo Check Out command to reset checked-out project points
back to a checked-in state.

Use this command if you checked out one or more points but do not want to
update the project with any changes you have made.

You can use this command only on project points that are checked out to
you.

To reset your checked out project points

1 In Toolspace, on the Prospector tab, expand the Projects collection and
then expand the project collection that contains the points you want to
reset.

2 Click the Points collection to display the list view.

3 In the list view, select the points to reset, right-click, and click Undo
Check Out.

4 In the Undo Check Out dialog box, click OK.
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Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

project Points collection  ➤  right-click selected points
in list view  ➤ Undo Check Out

Toolspace Short-
cut Menu

OR
Prospector tab: Open Drawings collection  ➤  drawing
Points collection  ➤  right-click selected points in list
view  ➤ Undo Check Out
OR
Prospector tab: Open Drawings collection  ➤ 

right-click <point group>  ➤ Undo Check Out

Dialog Box Undo Check Out Dialog Box

Resetting Points Checked Out to Someone Else

If you are a system administrator, you can use the Reset To Checked In
command to reset a checked-out project point to a checked-in state.

Use this command if a point is checked out and for some reason the person
who originally checked it out cannot undo the operation or check the point
back in.

NOTE The Reset to Checked In command is available only to a system
administrator.

To reset points checked out to someone else

1 In Toolspace, on the Prospector tab, expand the Projects collection, and
then expand the project collection that contains the points you want to
reset.

2 Click the Points collection to display the list view.

3 Select the checked-out points, right-click, and click Reset To Checked In.

4 In the Reset To Checked In dialog box, click OK.
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Quick Reference

Prospector tab (Master View): Projects collection  ➤ 

project Points collection  ➤  right-click selected points
in list view  ➤ Reset to Checked In

Toolspace Short-
cut Menu

Dialog Box Reset To Checked In Dialog Box

Data Shortcut Command Reference
You can use commands to quickly access data shortcuts functionality.

The following table lists Autodesk Civil 3D commands related to data shortcuts
and briefly describes their functionality.

DescriptionCommand

Creates an alignment reference.CreateAlignmentReference

Creates a profile reference.CreateProfileReference

Creates a surface reference.CreateSurfaceReference

Promotes all Data Shortcut reference objects in a
drawing to full-featured Autodesk Civil 3D objects
(page 16).

PromoteAllReference

Displays the Data Shortcuts vista.ShowShortcuts
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